Measuring Bluetooth Low Energy Power Consumption

Joakim Lindh, Christin Lee and Marie Hernes

ABSTRACT

This application report describes the setup and procedures to measure power consumption on CC2650, CC2640 and CC2640R2F devices operating as a Bluetooth® low energy “Peripheral” device.

The Power Calculation Tool discussed in the application report can be found from the following URL: www.ti.com/ble-power-calculator.

Contents

1 Introduction ................................................................................................................... 2
2 Understanding Bluetooth Low Energy Power Metrics .................................................... 3
3 SimpleLink Bluetooth Low Energy Wireless MCUs ....................................................... 4
4 Power Measurement Setup – Preparing the DUT ......................................................... 6
5 Measuring Power Consumption With a DC Power Analyzer ........................................ 13
6 References .................................................................................................................. 27

List of Figures

1 Current Consumption versus Time During a BLE Connection ........................................ 4
2 CC26xx Architectural Overview ................................................................................. 5
3 Device Under Test ..................................................................................................... 6
4 SmartRF06 Board Jumper Removal .......................................................................... 8
5 CC2650EM Antenna Option ...................................................................................... 9
6 CC2650 LaunchPad Jumper Removal ........................................................................ 10
7 BTool Serial Port Settings ......................................................................................... 11
8 BTool Connection Settings ...................................................................................... 11
9 BTool Scan ................................................................................................................ 12
10 BTool Scan Results ................................................................................................ 12
11 BTool Establish Link ............................................................................................... 12
12 BTool Connected Device ......................................................................................... 13
13 Agilent N6705B DC Power Analyzer ....................................................................... 13
14 DUT Test Setup ...................................................................................................... 14
15 Agilent 14585A Control and Analysis Software, Start-Up ....................................... 15
16 Agilent 14585A Control and Analysis Software, Connect ...................................... 15
17 Agilent 14585A Control and Analysis Software, Connected .................................. 16
18 Agilent 14585A Control and Analysis Software, Source Settings ......................... 17
19 Connecting the SmartRF06 Evaluation Board to Agilent 14585A ............................ 18
20 Connecting CC2650/CC2640R2 LaunchPad ............................................................ 18
21 Connected DUT to Agilent 14585A ....................................................................... 19
22 Agilent 14585A Control and Analysis Software, Scope ......................................... 19
23 Agilent 14585A Control and Analysis Software, Scope Setup ................................. 19
24 Agilent 14585A Control and Analysis Software, Instrument Range ..................... 20
25 Agilent 14585A Control and Analysis Software, Advertisement Capture .............. 20
1 Introduction

The Bluetooth low energy standard was developed with long battery life in mind, allowing devices to last several years while operating on a single coin-cell battery. It is assumed the reader of this application report has some knowledge of the BLE standard, as well as the Texas Instruments SimpleLink™ Bluetooth low energy CC2640 and CC2640R2F wireless microcontroller (MCU) with the Software Development Kit BLE-Stack.

In addition, it is assumed that the reader has some knowledge of basic electrical engineering concepts, and understands how to use laboratory test equipment such as an oscilloscope and DC power supply.

Power consumption measurements are presented, and battery life time is calculated for an example application. An accompanying Power Calculation Tool is provided so that you can estimate your battery life based on your own custom usage scenario.

Note that the results presented in this document are intended as guidelines. A variety of factors will influence the battery life of a Bluetooth low energy product. Measurements should be performed on hardware in a controlled environment, and under the target application scenario.

Also note that all waveforms and power consumption measurement results presented in this application report may not be up to date with the latest software optimizations.
1.1 Acronyms

Table 1. Acronyms Used in this Document

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM3</td>
<td>Cortex-M3</td>
</tr>
<tr>
<td>CPU</td>
<td>Central Processing Unit</td>
</tr>
<tr>
<td>DC</td>
<td>Direct Current</td>
</tr>
<tr>
<td>DK</td>
<td>Development Kit</td>
</tr>
<tr>
<td>DUT</td>
<td>Device under Test</td>
</tr>
<tr>
<td>EM</td>
<td>Evaluation Module</td>
</tr>
<tr>
<td>GAP</td>
<td>Generic Access Profile</td>
</tr>
<tr>
<td>GPIO</td>
<td>General-Purpose Input/Output</td>
</tr>
<tr>
<td>MCU</td>
<td>Microcontroller Unit</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>RF</td>
<td>Radio Frequency</td>
</tr>
<tr>
<td>RISC</td>
<td>Reduced Instruction Set Computer</td>
</tr>
<tr>
<td>RTC</td>
<td>Real Time Clock</td>
</tr>
<tr>
<td>RTOS</td>
<td>Real Time Operating System</td>
</tr>
<tr>
<td>RX</td>
<td>Receive</td>
</tr>
<tr>
<td>SCA</td>
<td>Sleep Crystal Accuracy</td>
</tr>
<tr>
<td>TX</td>
<td>Transmit</td>
</tr>
</tbody>
</table>

2 Understanding Bluetooth Low Energy Power Metrics

A Bluetooth low energy device achieves low power consumption by keeping radio activity short and allowing the device to reside in standby or power down mode most of the operating time.

The operation of a Bluetooth low energy device is typically static in the sense that it's staying in a certain mode for a certain amount of time, example when advertising or maintaining a connection. These modes are based on re-occurring events that can easily be used to estimated average power consumption. Each of these modes can be quantified into states for future estimations based on added data throughput or reduced latency (through higher connection interval, as an example).

The primary metric is the average current for the advertising and connected mode. It is these values that can be used to determine the battery life of a Bluetooth low energy device.

For a wireless MCU, such as the CC2650, it is important to understand that the device is typically not only running the Bluetooth low energy protocol stack, but it is also profile services and an application. The application may also be using peripherals on the chip, such as SPI or ADC. In addition, other devices on the circuit board, aside from the device running the Bluetooth low energy protocol stack, may be drawing current as well.

There are three main components of a Bluetooth low energy application that together sum up the average power consumption: Standby, Protocol Events and Application Events. Depending on the use case of the Bluetooth low energy device, these components will consume different amounts of power.
Measuring Bluetooth Low Energy Power Consumption

Figure 1 is based on a measurement of the current draw for a connected Bluetooth low energy device. The device spends most of the time in Standby, where the average current consumption is around 1 µA.

From Standby the device only wakes up based on either external interrupts or scheduled events/interrupts from the RTC. Standby also includes the recharge, which is further described in Section 5.3.2.

The Protocol Event is where communication over the Bluetooth low energy protocol occurs. For a Bluetooth low energy device, these events can be either Advertising Events or Connection Events. There are multiple roles featured that allow a Bluetooth low energy device to enter Observer role and scan as well but they are not covered in this application report.

The Application Event is the application specific implementation, for example, a periodic event, serial communication or running algorithms based on sensor inputs. Depending on the amount of activity, the application event may increase power consumption significantly, so always aim to optimize processing usage. The Application Events typically occur in between protocol events, which mean that a longer advertising or connection interval will give longer time slots for processing.

3 SimpleLink Bluetooth Low Energy Wireless MCUs

There are several Bluetooth low energy Solutions provided by Texas Instruments. These cover a wide range of solutions from simple broadcaster only to advanced multiple-role Real Time Operating System (RTOS) featured solutions, as shown in Table 2.

Table 2. Bluetooth Low Energy Solutions from Texas Instruments

<table>
<thead>
<tr>
<th></th>
<th>CC2540</th>
<th>CC2540T</th>
<th>CC2541</th>
<th>CC2541-Q1</th>
<th>CC2543</th>
<th>CC2544</th>
<th>CC2640</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Output Power</td>
<td>+4dBm</td>
<td>+4dBm</td>
<td>0 dBm</td>
<td>0 dBm</td>
<td>+5 dBm</td>
<td>+4 dBm</td>
<td>+5 dBm</td>
</tr>
<tr>
<td>TX current (0 dBm)</td>
<td>26 mA</td>
<td>26 mA</td>
<td>18.2 mA</td>
<td>18.2 mA</td>
<td>26 mA</td>
<td>27 mA</td>
<td>6.1 mA</td>
</tr>
<tr>
<td>Size (QFN)</td>
<td>6x6</td>
<td>6x6</td>
<td>6x6</td>
<td>6x6</td>
<td>5x5</td>
<td>5x5</td>
<td>4x4, 5x5, 7x7</td>
</tr>
<tr>
<td>BLE-Stack Support</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Broadcast only</td>
<td>Broadcast only</td>
<td>Yes</td>
</tr>
<tr>
<td>USB 2.0</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Key Features</td>
<td>USB</td>
<td>High Temp. &lt;125°C</td>
<td>I2C + Lower power</td>
<td>Automotive Qualified</td>
<td>Low cost</td>
<td>Low cost + USB</td>
<td>RTOS + Lowest power</td>
</tr>
</tbody>
</table>

(1) Single-ended RF mode is optimized for size and power consumption. Measured on CC2650EM-4XS.

This application report focuses on the CC2640, CC2640R2F and its superset device CC2650.

The CC2640/CC2640R2F is a Bluetooth low energy Wireless MCU providing a complete solution on a single chip. It runs three cores, which can be separately powered and controlled. The application processor is an ARM® Cortex®-M3 and it is used for running the Bluetooth low energy Profiles along with any user defined functionality. Application and part of the Bluetooth low energy protocol stack is sharing 20kB of RAM and up to 128kB of Flash.
The RF core ensures that all timing regarding the Bluetooth low energy protocol is being configured and handled properly. An ARM Cortex-M0 is dedicated for the radio operations and runs the BLE Radio Firmware from its own dedicated ROM.

The Sensor Controller includes a small proprietary RISC CPU that has been design to off-load the Cortex-M3. When the rest of the system is in standby, it can run small algorithms or communicate with sensors in a low power manner. It can wake up on interrupt and perform some simple processing and wake up the CM3 based on sensor input.

The Peripheral and Serial domain includes a wide set of peripheral modules, for serial communication, as well as general purpose IOs and timers.

The CC2650 can be powered by two supply ranges, as presented in Table 3. To enable the 1.8 V system, both hardware and software modifications are required, which is documented in the CC13xx, CC26xx SimpleLink™ Wireless MCU Technical Reference Manual [2].

<table>
<thead>
<tr>
<th>Supply Voltage</th>
<th>Internal DCDC</th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.8 V System (External Regulator Mode)</td>
<td>No</td>
<td>1.7 V</td>
<td>1.95 V</td>
</tr>
<tr>
<td>3.3 V System</td>
<td>Optional</td>
<td>1.80 V</td>
<td>3.80 V</td>
</tr>
</tbody>
</table>
For more information about CC2640, CC2640R2F and CC2650, see the CC2640 [3], CC2640R2F [4] and CC2650 Data Manuals [5], respectively.

4 Power Measurement Setup – Preparing the DUT

Before measurement and analysis can be performed, the device under test (DUT) must be prepared both from a hardware and software perspective. A peer device may also be configured in order to establish a connection. In this application report, a device running the example project HostTest is used to establish the connection. This project can be run on the CC2650/CC2640R2 LaunchPad, a CC2650EM or a CC2540 USB Dongle.

![Device Under Test](image)

Figure 3. Device Under Test

4.1 Requirements

To measure average power consumption for Bluetooth low energy, the following hardware from Texas Instruments are required:

- CC2650EM and SmartRF06EB
- Or
- CC2650/CC2640R2 LaunchPad
- And
- A device running HostTest project (for example, CC2650/CC2640R2 LaunchPad, CC2650EM mounted on SmartRF06EB or CC2540 USB Dongle) - Optional

CC2650EM and SmartRF06EB are included in the CC2650DK that can be purchased at the TI Store [6]. The CC2650/CC2640R2 LaunchPad (LP) can also be purchased at the TI Store. Note the difference of CC2650 and CC2640. The CC2650DK and the CC2650LP include the CC2650 multi-platform MCU evaluation module. The CC2650 is the superset device, which supports multiple protocols including Bluetooth low energy, and it can be interchanged with a CC2640 when working solely on a Bluetooth low energy application. So for a Bluetooth low energy solution, CC2650 and CC2640 are identical.

In terms of software resources, the following are required:

- BLE-Stack [7]
- IAR EWARM v.7.70.2 (or later) [8]
- or
- CCS Integrated Development Environment [9]
### 4.2 Embedded Software

The BLE-Stack is the Software Development Kit (SDK) for the CC26xx Bluetooth low energy devices provided by Texas Instruments. The software package includes full Bluetooth low energy (BT4.2) protocol stack along with sample applications. The protocol stack is provided as a pre-qualified library component and the complete system is operated by a RTOS that introduces a threaded environment with full power management. The power management is maintained by the RTOS automatically and the application can constrain tasks or disallow certain power modes if required. The power modes are presented in Table 4.

**Table 4. CC2650 Power Modes**

<table>
<thead>
<tr>
<th>Power Mode</th>
<th>Description</th>
<th>Current</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>System CPU is running</td>
<td>1.45 mA + 31 µA/MHz</td>
</tr>
<tr>
<td>Idle</td>
<td>The power domain in which CPU resides is off</td>
<td>550 uA</td>
</tr>
<tr>
<td>Standby</td>
<td>The voltage domain in which CPU resides is off</td>
<td>1 uA</td>
</tr>
<tr>
<td>Shutdown</td>
<td>Only IOs maintain their operation. All voltage regulators, voltage and power domains are off</td>
<td>0.1 uA</td>
</tr>
</tbody>
</table>

The generic sample application simple_peripheral that is included with the BLE-Stack is ideal to use in order to analyze power consumption for the sole Bluetooth low energy protocol running on a wireless MCU. To get a clean Bluetooth low energy protocol analysis, some modifications are required within the simple_peripheral sample application as observed in Table 5. This is needed because the purpose is to measure current consumption resulting from the BLE stack alone, so additional application processing must be turned off. The GPIO pins are per default already in a power-optimized state after board initialization. However, if you are using the CC2650LP or CC2640R2LP external flash needs to be turned off as it is enabled by default.

**Table 5. Software Modifications Required, SimpleBLEPeripheral**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Periodic Event</td>
<td>The only application processing that occurs is a periodic event that starts once a connection has been established. To eliminate the periodic event from the application, simply comment out the following line of source code from the GAPROLE_CONNECTED case in the SimpleBLEPeripheral_processStateChangeEvt function in the file simple_peripheral.c: //Util_startClock(&amp;periodicClock); By commenting out this line, the RTOS timer for the first periodic event will never get set.</td>
</tr>
<tr>
<td>LCD</td>
<td>Disable all screens by adding Display_DISABLE_ALL in the predefined symbols. In CCS go to Project Properties → Build → ARM Compile → Advanced Options → Predefined Symbols → Pre-define NAME. In IAR go to Project Options → C/C++ Compiler → Preprocessor → Defined symbols.</td>
</tr>
<tr>
<td>Connection Parameter Update</td>
<td>There is an automatic connection parameter request being sent from the peripheral device shortly after a connection has been established. It uses the parameters defined in simplePeripheral.c. For the measurement, it is more convenient to remove this feature and directly control connection parameters from the peer device. In simplePeripheral.c, change DEFAULT_ENABLE_UPDATE_REQUEST define to GAPROLE_LINK_PARAM_UPDATE_WAIT_REMOTE_PARAMS as shown below: #define DEFAULT_ENABLE_UPDATE_REQUEST GAPROLE_LINK_PARAM_UPDATE_WAIT_REMOTE_PARAMS</td>
</tr>
<tr>
<td>[CC2650LP/CC2640R2LP only] Add ExtFlash.c and ExtFlash.h</td>
<td>ExtFlash.c and ExtFlash.h are located in the TI-RTOS middleware (for CC2650LP, files are located at C:\ti\lirtos_cc13xx_cc26xx_2_18_00_03\products\ drivers\cc13xx\cc26xx_2_16_01_13\packages\ti\mw\extflash). For CC2640R2LP, files are located at C:\ti\simplelink_cc2640r2_sdk_1_00_00_22\source\ti\mw\extflash). Add them to the SBP application project by going to Project → Add Files (only possible in CCS Edit, not CCS Debug). Also, include them in simplePeripheral.c with the command: #include &lt;ti\mw\extflash\ExtFlash.h&gt;</td>
</tr>
<tr>
<td>[CC2650LP/CC2640R2LP only] Close external flash</td>
<td>Open and close the external flash by calling ExtFlash_open(); ExtFlash_close(); in SimpleBLEPeripheral_init().</td>
</tr>
</tbody>
</table>
For more information including instructions on how to program the CC2650, CC2640 and CC2640R2F, see the Software Developers Guide [1].

4.3 Hardware

4.3.1 SmartRF06

The SmartRF06 board includes many peripheral features. To get a clean measurement, it is important to remove a couple of jumpers as presented in Table 6; the visual location is observed in Figure 4. If these jumpers are not removed, there will be an additional current draw.

Table 6. SmartRF06 Jumper Removal

<table>
<thead>
<tr>
<th>Function</th>
<th>Jumper on SmartRF06</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>JTAG</td>
<td>P408</td>
<td>Note that this disables JTAG, which means that programming and debug capabilities become unavailable.</td>
</tr>
<tr>
<td>EM GPIO</td>
<td>P403, P404 and P405</td>
<td>Not all jumpers need to be removed, but for simplicity, it is better to remove them all.</td>
</tr>
<tr>
<td>UART</td>
<td>J5</td>
<td>UART enable</td>
</tr>
</tbody>
</table>

Figure 4. SmartRF06 Board Jumper Removal
Make sure to double check whether the EM needs an antenna or if it is using a PCB antenna. This is verified by observing R10/R11 on the EM, as shown in Figure 5.

![Using PCB Antenna](image1)

![Using SMA Connector](image2)

Figure 5. CC2650EM Antenna Option

**NOTE:** In SmartRF06 v121 and older, a small op amp is mounted next to R502. In that case, remove it or it will increase the power consumption during the measurement.
4.3.2 CC2650/CC2640R2 LaunchPad

To get a clean current measurement, the jumpers on the CC2650LP and CC2640R2LP should be removed. The Launchpad with all jumpers removed is showed in Figure 6. Note that when the JTAG jumpers are removed, the programming and debug capabilities of the chip become unavailable.

![Figure 6. CC2650 LaunchPad Jumper Removal](image)

Figure 6 applies for users that have CC2640R2 LP.

4.4 BTool (Optional)

The BLE-Stack also includes BTool along with drivers and firmware. BTool can be used to emulate a Bluetooth low energy application from a PC environment. BTool is used to create a connection with the DUT and if the intention is to measure power consumption of the DUT being in advertising or beacon mode, BTool is not required.

To connect to the DUT using BTool, a device running a Bluetooth low energy wireless network processor image named HostTest is required. This can be found with the other example projects in the BLE-Stack.

If you want to run HostTest on a CC2540 USB Dongle, the firmware image is found in the default install directory of the 1.4 BLE-Stack (\Accessories\HexFiles\CC2540_USBdongle_HostTestRelease_All.hex). (It is also bundled with the Device Monitor installer (http://processors.wiki.ti.com/index.php/BLE_Device_Monitor_User_Guide). To program the CC2540 USB Dongle, use SmartRF Flash Programmer 1 (http://www.ti.com/tool/flash-programmer). If the CC2540 USB Dongle is running the correct firmware, the LED on it should be lit red. (If the CDC Driver for the CC2540 USB Dongle does not automatically install, it is located in the default install directory of the 1.4 BLE-Stack (\Accessories\Drivers)).

With dongle connected to the PC, open up BTool. Choose the correct COM port that the HostTest device has been connected to.
Press OK and there should be an initialization process that is observed in the log window.

Before forming the connection, the proper connection parameters should be used. This will be dependent on the application that is being considered. The supervision timeout setting should not affect the power measurements. A connection interval of one second, with zero slave latency, will be used in this document. Therefore, use the values as shown in Figure 8. Be sure to select the “Set” button after entering in the values. Setting up the connection parameters needs to be done before a connection is established.

With the connection parameters set as needed, setup is completed.
At this point, BTool is ready to discover the DUT. If you left the SimpleBLEPeripheral application running on your DUT, you should be ready to use BTool. As long as the device running SimpleBLEPeripheral is powered up and not connected to anything, it should be in discoverable (advertising) mode.

In the Discovery section, press the “Scan” button, as shown in Figure 9.

![Figure 9. BTool Scan](image)

BTool will begin searching for Bluetooth low energy devices. After a couple of seconds, the device discovery process will finish. Alternatively, if you do not want to wait through the full 10 seconds of scanning, the “Cancel” button can be pressed, which will stop the device discovery process. The address of any scanned devices will appear in the “Slave BDA” section, as shown in Figure 10.

![Figure 10. BTool Scan Results](image)

To establish a connection with the peripheral device, select the address of the device to connect with, and click the “Establish” button, as shown in Figure 11.

![Figure 11. BTool Establish Link](image)
As long as the peripheral is powered-up and still in discoverable mode, a connection should immediately be established. Once a connection is established, the message window will return a “GAP_EstablishLink” event message with a “Status” value of “0x00 (Success)”. In BTool, you can see your connected peripheral device in the Device Information field, as shown in Figure 12.

![Figure 12. BTool Connected Device](image)

5 Measuring Power Consumption With a DC Power Analyzer

The easiest way of measuring power consumption is to utilize a DC Power Analyzer, which is far more advanced than a simple multimeter. Because the power consumption varies over time, a simple multimeter would not be sufficient anyway. An oscilloscope can be used as well, although the sampling rate and bandwidth must be good enough. For the purpose of this application report, an Agilent N6705B DC Power Analyzer is used (see Figure 13). The internal module is a N6781A, a 2-quadrant source and measure unit for battery drain analysis.

![Figure 13. Agilent N6705B DC Power Analyzer](image)
5.1 Test Setup

Make sure that the system is set up properly and review the steps described in Section 4. For reference, the full overview is illustrated in Figure 14. Note that the VDD is connected to the pin referred to as “VDD TO EM” on the SmartRF06. For the CC2650LP and CC2640R2LP, connect the VDD to the 3V3 pin.

When the DUT is correctly connected, the power supply is enabled by pressing the “On” button within the Agilent 14585A Control and Analysis Software. The power consumption measurements can be done by two separate functions: Scope or Data Logger. Data Logger provides an average power consumption measurement over longer time, for example minutes and hours, although the resolution is not as good as using Scope. This document focuses on doing measurements by using the Scope feature.

The Agilent N6705B powers the DUT as well as performs the current measurement.
5.1.1 Analysis Software Setup

All measurements and analysis can be done directly with the Agilent N6705B interface, but in this application report a PC Tool is used to control the Agilent N6705B. The PC Software used to control the Agilent N6705B is “Agilent 14585A Control and Analysis Software” v2.0.2.1. All software can be downloaded at http://www.keysight.com/ (in 2014, Agilent electronics instruments division was acquired by Keysight Technologies).

When the PC Tool is started, no external equipment is connected, which is observed in the “Instrument Control Tab”, as shown in Figure 15.

![Figure 15. Agilent 14585A Control and Analysis Software, Start-Up](image)

To connect the Agilent N6705B, make sure that it is connected via USB and that it is powered. Use the bottom left “Connect” button to select the connected hardware, as shown in Figure 16.

![Figure 16. Agilent 14585A Control and Analysis Software, Connect](image)
When the hardware has been successfully connected, it is fully controlled from the PC Tool, which is verified by the “Instrument Control” tab, as shown in Figure 17.

Figure 17. Agilent 14585A Control and Analysis Software, Connected
Note that the Output may be “On” per default (observed by the lit “on” button). If so, turn the Output off since the actual output parameters have not been configured yet. The next step is to configure the output. In the “Instrument Control” tab, click the “Settings” button to bring up the Source Settings for Output 1. Depending on the module within the Agilent N6705B, the options may be limited. Select “2 Quadrant Power Supply” and set the “Voltage” to 3V.

![Figure 18. Agilent 14585A Control and Analysis Software, Source Settings](image-url)
Connect the instrument probes to the DUT. For the SmartRF board, the VDD line goes to the “VDD TO EM” pin. The GND is most easily connected to the GND plane of the SmartRF06 board (see Figure 19).

For the CC2650/CC2640R2 LaunchPad, the VDD line should be connected to the 3V3 pin. The GND can be connected to any GND pin on the CC2650/CC2640R2 LP. Connecting to the CC2650/CC2640R2 LP is shown in Figure 20.

Figure 19. Connecting the SmartRF06 Evaluation Board to Agilent 14585A

Figure 20. Connecting CC2650/CC2640R2 LaunchPad
When the DUT is correctly connected, the power supply is enabled by pressing the “On” button within the Agilent 14585A Control and Analysis Software. The power consumption measurements can be done by two separate functions: Scope or Data Logger. Data Logger provides an average power consumption measurement over longer time, for example, minutes and hours, although the resolution is not as good as using Scope. This document focuses on doing measurements by using the Scope feature.

![Figure 21. Connected DUT to Agilent 14585A](image)

### 5.2 Measurement Using Scope

When the instrument has been correctly setup and configured, make sure that Scope has been selected, as shown in Figure 22.

![Figure 22. Agilent 14585A Control and Analysis Software, Scope](image)

The scope mode allows that measurement be ran over a short amount of time. In order to maximize the amount of data, setup the parameters (see Figure 23).

- Resolution: 200ms / div
- Points: 512k
- Trigger: Scope Run Button
- Mode: Single
- Slope: Rising Edge

![Figure 23. Agilent 14585A Control and Analysis Software, Scope Setup](image)
Next, make sure that the “Ranges…” is setup to AUTO, as shown in Figure 24.

![Figure 24. Agilent 14585A Control and Analysis Software, Instrument Range](image)

The instrument should now be setup properly and the measurement can start. Click the Play button in the bottom right corner → allow the instrument to start the measurement.

### 5.3 Analysis

Depending on what the DUT is setup to do, the result will vary. If no interaction has been made with the DUT, it will be sending out periodic advertisements each 100 ms.

![Figure 25. Agilent 14585A Control and Analysis Software, Advertisement Capture](image)
The approximately 2.66s measurement includes 26 advertising events and in between, during Standby, there is a recharge pulse.

There is functionality to do detailed measurements of the acquired waveform. Select “Markers & Measurements” to enable the markers, which can be used to obtain average power consumption. There are two approaches of using the markers:

- Measure the average power consumption from a symmetric point of the measurement, (for example, from the start of an event to the point where the next event starts). This will give an approximation of the overall power consumption over time because of the reoccurring symmetry.
- Break down the events into states to be used for various use case studies and estimations. This is very useful in order to analyze the resulting power consumption when intervals are changed.

If the objective is to simply obtain a power consumption figure of the DUT, the first option is fast and reliable.

### 5.3.1 Advertising Event

An advertising event is where the (Bluetooth low energy) peripheral device broadcasts information in order to either share information or become connected to a (Bluetooth low energy Ready) Central device, such as a smart phone. The device wakes up and broadcasts packets on three separate channels and listens on each of these channels for Scan Requests or Connection Requests. Scan requests is a way for a Central device to obtain more information about the device before connecting, because the advertising data is typically chosen to be very short to minimize power consumption. Based on advertising data or the scan response data, connection requests can be sent, which initiates a connection between the Peripheral and the Central.

With connectable advertising packet format, the base time of data transmitting is 144 µs which contains 1 byte preamble, 4 bytes Access Address, 2 bytes PDU, 3 bytes CRC and 6 bytes AdvA in the payload. For every additional transmitted bit, 1 µs should be added to the TX time.

The Agilent 14585A Control and Analysis Software “Markers & Measurements” functions are used to quantify a single advertising event, which is visualized in Figure 26 and summarized in Table 7.

![Figure 26. Connectable Advertising Event, Capture](image-url)
### Table 7. Advertising Event, State Analysis

<table>
<thead>
<tr>
<th>State</th>
<th>Time [µs]</th>
<th>Current [mA]</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 pre-processing</td>
<td>1160</td>
<td>3.26</td>
<td>RTOS wake-up, radio setup, XTAL guard time</td>
</tr>
<tr>
<td>2 Radio preparation</td>
<td>101</td>
<td>4.3</td>
<td>Radio is turned on and in transition to TX</td>
</tr>
<tr>
<td>3 TX</td>
<td>168</td>
<td>7.47</td>
<td>The radio transmits an advertisement packets with 3 bytes data on Channel 37. Time is dependent on amount of transmitted data</td>
</tr>
<tr>
<td>4 TX to RX transition</td>
<td>112</td>
<td>4.66</td>
<td>TX to RX transition</td>
</tr>
<tr>
<td>5 RX</td>
<td>184</td>
<td>6.47</td>
<td>Time depends on advertising interval and SCA</td>
</tr>
<tr>
<td>6 RX to TX transition</td>
<td>370</td>
<td>3.43</td>
<td>RX to TX transition</td>
</tr>
<tr>
<td>7 TX</td>
<td>168</td>
<td>7.47</td>
<td>The radio transmits an advertisement packets with 3 bytes data on Channel 38. Time is dependent on amount of transmitted data</td>
</tr>
<tr>
<td>8 TX to RX transition</td>
<td>112</td>
<td>4.66</td>
<td>TX to RX transition</td>
</tr>
<tr>
<td>9 RX</td>
<td>184</td>
<td>6.47</td>
<td>Time depends on advertising interval and SCA</td>
</tr>
<tr>
<td>10 RX to TX transition</td>
<td>370</td>
<td>3.43</td>
<td>RX to TX transition</td>
</tr>
<tr>
<td>11 TX</td>
<td>168</td>
<td>7.47</td>
<td>The radio transmits an advertisement packets with 3 bytes data on Channel 39. Time is dependent on amount of transmitted data</td>
</tr>
<tr>
<td>12 TX to RX transition</td>
<td>112</td>
<td>4.66</td>
<td>TX to RX transition</td>
</tr>
<tr>
<td>13 RX</td>
<td>184</td>
<td>6.47</td>
<td>Time depends on advertising interval and SCA</td>
</tr>
<tr>
<td>14 Post-processing and going to standby</td>
<td>685</td>
<td>2.45</td>
<td>BLE protocol stack processes the received packets and sets up the sleep timer in preparation for the next event. And then going to standby afterwards</td>
</tr>
</tbody>
</table>

This is also the event occurring when a device is in beacon mode. For a non-connectable beacon, there are no RX states during the advertising event, which reduces the power consumption further.

![Figure 27. Beacon Event, Capture](image-url)
### Table 8. Beacon Event, State Analysis

<table>
<thead>
<tr>
<th>State</th>
<th>Time [µs]</th>
<th>Current [mA]</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Pre-processing</td>
<td>1160</td>
<td>3.26</td>
<td>RTOS wake-up, radio setup, XTAL guard time</td>
</tr>
<tr>
<td>2 Radio preparation</td>
<td>101</td>
<td>4.3</td>
<td>Radio is turned on and in transition to TX</td>
</tr>
<tr>
<td>3 TX</td>
<td>144</td>
<td>7.47</td>
<td>The radio transmits an advertisement packets with 3 bytes data on Channel 37. Time is dependent on amount of transmitted data</td>
</tr>
<tr>
<td>4 TX-to-TX transition</td>
<td>372</td>
<td>3.56</td>
<td>TX to TX transition</td>
</tr>
<tr>
<td>5 TX</td>
<td>144</td>
<td>7.47</td>
<td>The radio transmits an advertisement packets with 3 bytes data on Channel 38. Time is dependent on amount of transmitted data</td>
</tr>
<tr>
<td>6 TX-to-TX transition</td>
<td>372</td>
<td>3.56</td>
<td>TX to TX transition</td>
</tr>
<tr>
<td>7 TX</td>
<td>144</td>
<td>7.47</td>
<td>The radio transmits an advertisement packets with 3 bytes data on Channel 39. Time is dependent on amount of transmitted data</td>
</tr>
<tr>
<td>8 Post-processing and going to standby</td>
<td>685</td>
<td>2.45</td>
<td>BLE protocol stack sets up the sleep timer in preparation for the next event. And then going to standby afterwards</td>
</tr>
</tbody>
</table>

#### 5.3.2 Standby

Standby is the power mode in between the advertising (and connection) event, which includes a VDDR recharge. The recharge is a mandatory function during Standby in order to retain RAM and make sure that the clocks are powered. The power consumption in between these recharges are around 70 nA, almost too small to even measure. It is the average power consumption during Standby including recharge that is defined as the Standby current, as about 1 µA in the CC2640, CC2640R2F and CC2650 data manual. It is also important to know that this number is not fixed as the recharge pulses are dynamically adapted based on the required time in Standby. If the measurement was performed immediately after a reset of the DUT, there will be many more recharges between the advertising and connection events and over a few seconds the amount of recharges will reduce to the mandatory 1 event. This means that Standby will go from a slightly higher value, down to an optimum. The higher value has been measured to 2 µA.

![Figure 28. VDDR Recharge](image-url)
For longer standby intervals, there will be a few more recharge pulses. One example is observed if the DUT enters a connection. The Standby current can be measured by placing the markers between two Advertising and Connection events. In Figure 29, the DUT is advertising with a 100 ms interval and there is a recharge in between the advertising events; in this case, the resulting Standby current is 1.57 µA. The Standby current will not go lower than this when advertising with a 100 ms connection interval.

![Image](image_url)

**Figure 29. Measuring Standby Current During Advertisement**

When a connection has been established as described in Section 5.3.3, similar measurement can be done, resulting in an optimum of 0.88 µA due to the long connection interval of 1 s (with two recharges in between).

![Image](image_url)

**Figure 30. Measuring Standby Current During Connection**
5.3.3 Connection Event

When a connection has been established between a Peripheral and a Central device, they communicate during connection events. The Central device operates as the master and the Peripheral device as the slave.

All communication between two connected devices occurs on these connection events. They are periodically with a configurable connection interval, ranging from 7.5 ms to 4 seconds.

Each event occurs on one of the 37 data channels and the Master always initiates the event, with the slave listening. They can continue to communicate back and forth as much as they want during one connection event.

Connection events occur even if neither side has data to send. This ensures that the link is still valid. If a specified number of connection events occur without acknowledgment, the connection will be considered lost.

In order to measure a Connection Event, the DUT must be connected to a peer device. By using BTool as described in Section 4.4, a connection with 1 second connection interval is established.

To measure the average power consumption, the easiest way is to identify the re-occurrence and measure the average current for that part. It will represent the average power consumption for that mode device is running in. For a connection, it's done by placing the one marker right after a connection event, as shown in Figure 31, and the second marker after the next connection event, as shown in Figure 32. The average current is then observed in Figure 32, as approximately 9.94 µA.
Figure 32. Connection Event, Marker #2 Placement

The Connection Event can also be quantified to fully analyze the various states by using the Select “Markers & Measurements”, similar as with the advertising event, as shown in Figure 33 and Table 9.

Figure 33. Current Consumption versus Time During a Single Connection Event
Table 9. Connection Event, State Analysis

<table>
<thead>
<tr>
<th>State</th>
<th>Time [µs]</th>
<th>Current [mA]</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Pre-processing</td>
<td>1165</td>
<td>3.22</td>
<td>RTOS wake-up, radio setup, XTAL guard time</td>
</tr>
<tr>
<td>2 Radio preparation</td>
<td>132</td>
<td>3.99</td>
<td>Radio is turned on and in transition to RX</td>
</tr>
<tr>
<td>3 Receive (RX)</td>
<td>129</td>
<td>6.48</td>
<td>The radio receiver listens for a packet from the master. Time depends on connection interval and SCA.</td>
</tr>
<tr>
<td>4 RX to TX transition</td>
<td>149</td>
<td>5.49</td>
<td>RX to TX transition</td>
</tr>
<tr>
<td>5 Transmit (TX)</td>
<td>90</td>
<td>7.66</td>
<td>The radio transmits a packet to the master on one of the 37 channels. Time is dependent on the amount of transmitted data</td>
</tr>
<tr>
<td>6 Post-processing and going to standby</td>
<td>775</td>
<td>2.59</td>
<td>BLE protocol stack processes the received packets and sets up the sleep timer in preparation for the next event. And then going to standby afterwards</td>
</tr>
</tbody>
</table>

5.3.4 Power Consumption Calculation

The state analysis from advertising and connection states can be used to investigate how the battery life varies depending on connection interval. For that purpose, a Power Calculation Tool is provided that can be used to perform calculations for your custom application.

6 References

1. CC2640 and CC2650 SimpleLink™ Bluetooth® low energy Software Stack 2.2.1 Developer’s Guide (http://www.ti.com/lit/pdf/swru393)
3. CC2640 SimpleLink™ Bluetooth® Wireless MCU Data Manual (SWRS176)
4. CC2640R2F SimpleLink™ Bluetooth® low energy Wireless MCU Data Manual (SWRS204)
5. CC2650 SimpleLink™ Multistandard Wireless MCU Data Manual (SWRS158)
6. TI Store: https://store.ti.com/
7. BLE-Stack™: www.ti.com/ble-stack
8. IAR Embedded Workbench™ for ARM: http://www.iar.com/Products/IAR-Embedded-Workbench/ARM/
## Revision History

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

### Changes from B Revision (December 2016) to C Revision

<table>
<thead>
<tr>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update was made in the Abstract of this document.</td>
<td>1</td>
</tr>
<tr>
<td>Update was made in Section 1.</td>
<td>2</td>
</tr>
<tr>
<td>Updates were made in Section 3.</td>
<td>4</td>
</tr>
<tr>
<td>Update was made in Section 4.</td>
<td>6</td>
</tr>
<tr>
<td>Updates were made in Section 4.1.</td>
<td>6</td>
</tr>
<tr>
<td>Updates were made in Section 4.2.</td>
<td>7</td>
</tr>
<tr>
<td>Update was made in Section 4.3.2.</td>
<td>10</td>
</tr>
<tr>
<td>Update was made in Section 5.1.</td>
<td>14</td>
</tr>
<tr>
<td>Update was made in Section 5.3.2.</td>
<td>23</td>
</tr>
</tbody>
</table>
IMPORTANT NOTICE FOR TI DESIGN INFORMATION AND RESOURCES

Texas Instruments Incorporated ("TI") technical, application or other design advice, services or information, including, but not limited to, reference designs and materials relating to evaluation modules, (collectively, "TI Resources") are intended to assist designers who are developing applications that incorporate TI products; by downloading, accessing or using any particular TI Resource in any way, you (individually or, if you are acting on behalf of a company, your company) agree to use it solely for this purpose and subject to the terms of this Notice.

TI's provision of TI Resources does not expand or otherwise alter TI's applicable published warranties or warranty disclaimers for TI products, and no additional obligations or liabilities arise from TI providing such TI Resources. TI reserves the right to make corrections, enhancements, improvements and other changes to its TI Resources.

You understand and agree that you remain responsible for using your independent analysis, evaluation and judgment in designing your applications and that you have full and exclusive responsibility to assure the safety of your applications and compliance of your applications (and of all TI products used in or for your applications) with all applicable regulations, laws and other applicable requirements. You represent that, with respect to your applications, you have all the necessary expertise to create and implement safeguards that (1) anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that might cause harm and take appropriate actions. You agree that prior to using or distributing any applications that include TI products, you will thoroughly test such applications and the functionality of such TI products as used in such applications. TI has not conducted any testing other than that specifically described in the published documentation for a particular TI Resource.

You are authorized to use, copy and modify any individual TI Resource only in connection with the development of applications that include the TI product(s) identified in such TI Resource. NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information regarding or referencing third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement thereof. Use of TI Resources may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

TI RESOURCES ARE PROVIDED "AS IS" AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING TI RESOURCES OR USE THEREOF, INCLUDING BUT NOT LIMITED TO ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY YOU AGAINST ANY CLAIM, INCLUDING BUT NOT LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS EVEN IF DESCRIBED IN TI RESOURCES OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF TI RESOURCES OR USE THEREOF, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

You agree to fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of your non-compliance with the terms and provisions of this Notice.

This Notice applies to TI Resources. Additional terms apply to the use and purchase of certain types of materials, TI products and services. These include: without limitation, TI's standard terms for semiconductor products (http://www.ti.com/sc/docs/stdterms.htm), evaluation modules, and samples (http://www.ti.com/sc/docs/sampterms.htm).

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2018, Texas Instruments Incorporated